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Abstraksi 
Iklan Hotel Mawar Asri merupakan sebuah iklan promosi yang berupa ajakan masyarakat luar yang ingin 

mencari tempat bermalam yang ada di Yogyakarta. Masih banyak kendala yang dihadapi saat ini untuk menjadi 

hotel yang baik dan bisa dikenal. Mulai dari manajemen yang masih kurang terkondisi dengan baik, dan 

promosi yang kurang untuk mengenal Hotel Mawar Asri ke masyarakat luar. Pembuatan iklan televise 

menggunakan teknik motion tracking adalah salah satu solusi untuk menyelesaikan permasalahan yang ada di 

hotel Mawar Asri Yogyakarta. Motion capture, motion tracking, atau mocap adalah terminologi yang digunakan 

untuk mendeskripsikan proses dari perekaman gerakan dan pengartian gerakan tersebut menjadi model digital. 

Perlu adanya perubahan yang harus dilakukan supaya hotel ini bisa dikenal oleh masyarakat luar. Diharapkan 

nantinya bisa menarik banyak pengunjung untuk datang ke Hotel Mawar Asri Yogyakarta. 

Kata kunci :  
Iklan, Hotel, Motion Tracking 

 

Pendahuluan 
Penggunaan iklan sebagai media promosi untuk 

sebuah layanan jasa sudah banyak digunakan dan 

semakin berkembang, terutama penggunaan iklan 

di televisi. Semakin berkembangnya metode yang 

digunakan agar menarik para penonton iklan 

tersebut. Media televisi merupakan salah satu 

media yang efektif untuk beriklan. Hal ini 

dikarenakan iklan televisi mempunyai karakteristik 

khusus yaitu kombinasi gambar, suara dan gerak. 

Iklan yang dibuat penulis ini adalah iklan televisi 

dengan penggabungan Motion tracking, Green 

Screen dan Animasi. 

Terkendala dalam hal pemasaran yang saat ini 

dilakukan hanyalah melalui Website, sehingga 

pemasaranya kurang maksimal dan itu berdampak 

pada pendapatan dan volume pengunjung. 

Sementara promosi yang dilakukan hanya bersifat 

cetakan pamflet belum berbentuk multimedia 

seperti iklan televisi. 

Dari masalah tersebut maka penulis akan membuat 

iklan televisi, dengan penggabungan Motion 

tracking, Green Screen dan Animasi dalam 

merancang iklan televisi untuk Hotel Mawar Asri 

Yogyakarta yang diharapkan dapat membantu 

kegiatan promosi sehingga menarik penonton 

khususnya para penggunjung kota Yogyakarta. 

Penggabungan Motion tracking, Green Screen dan 

Animasi adalah inti dari skripsi yang penulis ambil, 

yaitu Analisis dan Perancangan Iklan Televisi Hotel 

Mawar Asri Yogyakarta sebagai media Promosi. 

Adapun tujuan yang ingin dicapai dalam 

penyusunan penelitian ini membuat iklan televisi 

Hotel Mawar Asri Yogyakarta sebagai media 

promosi. Pembuatan sebuah iklan layanan jasa 

melibatkan banyak elemen di dalamnya. Sehingga 

penulis menetapkan batasan-batasan masalah pada 

penelitian ini sebagai berikut:  

1. Penelitian ini memfokuskan mengenai 

pembuatan iklan televisi dengan menggunakan 

penggabungan Motion tracking, Green Screen 

dan Animasi. 

2. Pembuatan iklan yang dibahas adalah 

pembuatan iklan layanan jasa. 

3. Iklan ini menggunakan penggabungan Motion 

tracking, Green Screen dan Animasi. 

4. Sofware yang digunakan Adobe After Effects 

CS6 sebagai software pengolah video, Adobe 

Premier CS6 sebagai software pengolah 

animasi dan Adobe Photosop CS6 sebagai 

software pengolah foto. 

5. Durasi iklan layanan masyarakat ini sekitar  30 

detik. 

Manfaat dari penelitian ini adalah membantu 

manajemen mempromosikan Hotel Mawar Asri 

Yogyakarta, selain itu juga untuk meningkatkan 

pendapatan dan pengunjung bagi Hotel Mawar Asri 

Yogyakarta lewat media promosi iklan televisi. 

Tinjauan Pustaka 
Ditinjau dari hasil penelitiana yang bernama 

Rachmawati Fitri (2013) jurusan Sistem Informasi 

STMIK AMIKOM Yogyakarta dengan judul 

“IMPLEMENTASI ANIMASI 3D, MOTION 

GRAPHIC DAN VISUAL EFEK PADA IKLAN 

TELEVISI FLASH 3M AUTOCARE 

YOGYAKARTA” iklan yang dibuat dengan 

maksud dan tujuan untuk membantu kegiatan 

promosi dan publikasi sehingga menarik konsumen 

untuk melakukan perawatan mobil pada Flash 3M 

Autocare. Sedangkan penelitian yang dilakukan oeh 

Raditya Maulana Anuraga (2014) jurusan Sistem 

Informasi STMIK AMIKOM Yogyakarta dengan 

judul “ANALISIS DAN PERANCANGAN 

IKLAN TELEVISI BATIK PUTRA LAWEYAN 
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SOLO SEBAGAI MEDIA PROMOSI BERBASIS 

MULTIMEDIA” iklan yang dibuat dengan maksud 

dan tujuan untuk memperluas pemasaran pe-

rusahaan dalam mempromosikan Batik Putra La-

weyan Solo. 

Tujuan dari penelitian ini sama dengan peneliti 

sebelumnya yaitu untuk menarik konsumen supaya 

menggunakan jasa dari perusahaan yang di-

iklankan, tetapi menggunakan teknik yang berbeda, 

yaitu menggunakan teknik motion tracking untuk 

menghasilkan iklan live shoot yang lebih elegan 

dalam visualnya sehingga pesan yang disampaikan 

lebih mengena dan memberikan kesan yang 

berbeda bagi yang melihat iklan ini. 

Iklan sebagai kegiatan komunikasi menurut guin, 

Allen dan Semenik dalam buku yang berjudul 

Advertising and Integrated Brand Promotion 

mengemukakan bahwa periklanan merupakan 

proses komunikasi [1]. 

Periklanan (advertising) adalah suatu proses ko-

munikasi massa yang melibatkan sponsor tertentu, 

yakni si pemasang iklan (pengiklan), yang mem-

bayar jasa sebuah media massa atas penyiaran 

iklannya, misalnya melalui program siaran televisi. 

Adapun iklannya itu sendiri biasanya dibuat atas 

bisa saja oleh bagian Humas (Public Relation) 

lembaga pemasang iklan itu sendiri. Periklanan 

dapat juga dianggap sebagai sebuah institusi sosial, 

sebab banyak lembaga kemasyarakatan yang 

terlibat di dalam proses pembuatan dan penyajian 

iklannya. Dengan demikan periklanan bisa di-

anggap sebuah cermin masyarakat, atau bisa juga di 

anggap sebgai penaruh dari zamannya [2]. 
Motion Tracking adalah sebuah teknik editing pada 

software adobe after effect dengan menggunkan 

tool tracker sehingga sebuah objek dapat dikaitkan 

dengan objek yang ada dalam gambar. Objek-objek 

tersebut dapat mengikuti gerak objek yang berada 

didalam video tanpa menempel pada gerakan 

kamera. Definisi Motion Tracking adalah proses 

pengaturan nilai untuk menentukan jarak pada 

setiap objek maupun gerakanya. Nilai positif pada 

motion atau gerakan maupun tracking akan 

membuat jarak setiap karakter terpisah semakin 

jauh. Apabila menggukan negative, maka jarak 

setiap karakter akan dekat dan seakan-akan 

menyatu [3]. 

Suara Mempunyai peranan yang penting dalam 

penyampaian informasi atau hiburan terutama 

dalam iklan tv. Dalam teknologi multimedia, jika 

pemakaian PC (Personal Computer) menginginkan 

keluaran suara atau suara yang jernih, maka yang 

perlu diperhatikan adalah kualitas sound card yang 

perpasang pada PC tersebut. Berkaitan daengan 

informasi multimedia yaitu dapat memanfaatkan 

seluruh indera manusia terutama mata dan 

telinga[4]. 

Komunikasi pemasaran adalah salah satu dari 

empat elemen utama promosi perusahaan maupun 

instansi pemerintah. Pemasar dan pengiklan harus 

tahu bagaimana menggunakan iklan, promosi, pen-

jualan, publisitas, dan penjualan personal, untuk 

mengkomunikasikan suatu produk beserta nilainya 

kepada konsumen yang di tuju / target. Proses 

komunikasi itu sendiri terdiri dari Sembilan elemen 

yaitu : penyampaian pesan, penerima pesan, pe-

nyandian, pembaca sandi, pesan, media, tanggapan, 

umpan balik, dan gangguan. Pemasar harus tahu ba-

gaimana cara untuk mencapai khalayak sasaran, 

berhadapan dengan kecenderungan khalayak pada 

perhatian selektif, distorsi (pemutar balikan pesan), 

dan mengingat pesan. Diperlukan delapan tahap 

untuk menetapkan program promosi. Pertama, ko-

munikator harus mengidentifikasi khalayak sasaran 

dan cirri-cirinya, termasuk citra mereka terhadap 

produk. Komunikator menentukan tujuan ko-

munikasi, apakah untuk meciptakan perkenalan, pe-

ngetahuan, kesuksesan, pilihan, keyakinan, atau pe-

mbelian. Pesan harus dirancang efektif yang 

meliputi isi, struktur, format, dan sumber. Saluran-

saluran komunikasi personal maupun non personal 

harus diseleksi. Anggaran promosi yang menyentuh 

harus ditetapkan. Biaya promosi harus didistibusi-

kan menurut alat-alat utama promosi yang diguna-

kan. Komunikator harus menelusuri seberapa ba-

nyak pasar yang mengenal produk itu, mencoba, 

dan puas terhadap produknya selama promosi. 

Terakhir, semua komunikasi harus dikelola dan 

dikoordinasi agar konsisten, tepat dan efektif [5]. 

Dalam pengembangan sistem multimedia diperlu-

kan langkah-langkah tepat dan ini akan berhasil jika 

dilakukan melalui pendekatan dengan berbagai sis-

tem yang ada seperti pendekatan yang melibatkan 

pemakai sebagai pengguna akhir, professional ko-

munikasi yang membantu dalam menemukan ke-

seluruhan pesan dan spesialisasi informasi sebagai 

pengembangan keseluruhan sistem multimedia 

Menurut Raymond McLeod ada beberapa langkah 

khusus yang perlu diperhatikan dalam me-

ngembangkan sistem multimedia, diantaranya:[6] 
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Gambar 1.Tahap Pengembangan Multimedia 

 

1. Konsep (concept) 

Tahap konsep yaitu menentukan tujuan, termasuk 

identifikasi audiens, macam aplikasi (presesentasi, 

interaktif, dan lain-lain), tujuan aplikasi (informasi, 
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hiburan, pelatihan, dan lain-lain) dan spesifikasi 

umum. Dasar aturan untuk perancangan juga di 

tentukan pada tahap ini, seperti ukuran aplikasi, 

target, dan lain-lain. 

Dalam tahap konsep perlu di perhatikan : 

a. Menentukan pada tahap ini di tentukan tujuan 

dari multimedia, serta user yang menggunaka-

nnya. Tujuan dari user berpengaruh pada 

nuansa multimedia, sebagai pencerminan iden-

titas dari organisasi yang menginginkan infor-

masi sampai kepada user. 

b. Memahami karakteristik user. Tingkat kemam-

puan audiens sangat mempengaruhi pembuatan 

desain. Dengan demikian multimedia dapat di-

katakan komunikatif. 

Output dari tahapan konsep biasanya dokumen 

dengan penulisan yang bersifat naratif untuk 

mengungkapkan tujuan proyek. 

2. Perancangan (design) 

Tahap perancangan atau desain adalah pembuatan 

spesifikasi secara rinci mengenai  Arsitektur pro-

yek, gaya, dan kebutuhan material untuk proyek. 

Spesifikasi di buat cukup rinci sehingga pada tahap 

berikutnya, yaitu mengumpulkan bahan dan pe-

rakitan tidak di perlukan keputusan baru, tetapi 

menggunakan apa yang sudah ditentukan pada 

tahap desain. Namun demikian, sering terjadi 

penambahan bahan atau bagian aplikasi ditambah, 

dihilangkan,atau diubah pada awal pengerjaan 

proyek. 

System authoring bermanfaat pada tahap desain dan 

dengan mudah menenmpatkan parameter ke dalam 

system seperti yang telah di tentukan. Bentuk 

authoring yang sering digunakan dalam pengem-

bangan multimedia adalah menguraikan, story-

board, flowchart, pemodelan, dan scripting. Ber-

macam-macam perancangan dapat dibagi menjadi 

tiga macam yaitu: 

a. Desain berbasis multimedia. Metode desain ini 

di kembangkan dari metode perancangan pem-

buatan film menggunakan storyboard. Dalam 

perkembangan multimedia memerlukan aspek 

interaktif, sehingga di lengkapi dengan flow-

chart view. 

b. Desain struktur navigasi. Struktur navigasi 

memberikan gambaran link dari halaman satu 

ke halaman lainnya. Struktur navigasi diguna-

kan pada multimedia non-linier, dan diadaptasi 

dari desain web. 

c. Desain berorientasi obyek. Metode desain 

berorientasi pada obyek (object-oriented 

design) adalah metode perancangan dimana 

komponen multimedia dinyatakan sebagai 

objek. Desain berorientasi obyek juga digunak-

an pada banyak sistem yang terdiri dari obyek, 

seperti CAD/CAM, sistem informasi geografis, 

dan lain-lain. 

3. Pengumpulan Bahan (material collecting) 

Pengumpulan bahan atau material collecting  

adalah kegiatan pengumpulan bahan yang dapat 

dikerjakan parallel dengan tahap perakitan. Pada 

tahap ini dilakukan pengumpulan bahan seperti 

clipart image, animasi, audio, berikut pembuatan 

gambar grafik, foto, audio dan lain-lain diperlukan 

untuk tahap berikutnya. Bahan yang diperlukan 

dalam multimedia dapat diperoleh dari sumber-

sumber seperti library, bahan yang sudah ada pada 

pihak lain, atau pembuatan khusus yang dilakukan 

oleh pihak luar. 

Bila digunakan komponen yang berasal dari sumber 

internal atau eksternal, tidak diperlukan Tool  untuk 

pembuatan, tetapi diperlukan konversi file sehingga 

dapat digunakan dalam dalam proyek. Dengan 

sistem operasi multitasking seperti DOS, Windows, 

dan OS2, tidak perlu khawatir karena sistem 

operasi dapat menangani keperluan tersebut [5]. 

4. Pembuatan (assembly) 

Tahap pembuatan atau assembly merupakan tahap 

dimana seluruh obyek multimedia dibuat. Pem-

buatan aplikasi berdasarkan storyboard, flowchart 

view, struktur navigasi, atau diagram obyek yang 

berasal dari tahap desain. Contohnya pada pem-

buatan presentasi, pembuatan dilakukan dengan 

memasukkan data yang digunakan untuk berbagai 

tampilan, serta menentukan screen dengan urutan-

nya. 

Pembuatan obyek multimedia menggunakan pe-

rangkat lunak tertentu dapat dilakukan untuk 

mendukung hasil yang lebih menarik seperti 

penggunaan animasi dan suara untuk memperjelas 

materi di dalam obyek multimedia tersebut. 

5. Pengujian (testing) 

Pengujian atau testing dilakukan setelah selesai ta-

hap pembuatan dan seluruh data telah dimasukkan. 

Dalam penelitian ini, pengujian dilakukan dengan 

cara menayangkan video yang sudah ada dengan 

menggunkan beberapa player video, diantaranya 

Windows media player, kmp, k-lite, vlc dan quic 

time yang bertujuan untuk memastikan player mana 

yang dapat dipakai untuk memutar video dengan 

kondisi paling baik. Pada penelitian ini adalah 

dengan menggunkan kmp player. 

6. Distribusi 

Tahap distribusi merupakan tahap dimana evaluasi 

terhadap suatu produk multimedia yang selesai 

dikerjakan. Dalam penelitian ini distribusi yang di-

lakukan adalah dengan cara menayangkan iklan ini 

di stasiun televisi RBTV Yogyakarta, selain distri-

busi dalam tahap ini sekaligus untuk megujikan 

standard broadcast yang dipakai sudah sesuai atau 

belum. Iklan ini sudah dapat ditayangkan di RBTV 

dengan baik, sehingga standard broadcast yang 

digunakan sudah sesuai. 

Metode Penelitian 
Metode penelitian yang digunakan dalam penelitian 

ini adalah: 
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a. Metode Survey 

Yaitu metode dengan cara mengajukan pertanyaan 

pada orang-orang dan merekam jawabanya untuk 

dianalisis. Dalam penelitian ini dilakukan proses 

penayangkan hasil iklan di hadapan pemilik pe-

rusahaan. 

b. Metode Kepustakaan 

Merupakan metode yang digunakan untuk men-

dapatkan informasi atau konsep-konsep teoritis 

menggunakan buku sebagai bahan referensi. 

c. Studi Literatur 

Dalam studi ini, mengacu pada metode pengambil-

an data menggunakan fasilitas yang ada seperti 

dengan menggunakan fasilitas media  internet se-

bagai acuan dalam pembuatan, yaitu mengunjungi 

situs-situs web yang berhubungan dengan pem-

buatan iklan, pemakaian Motion tracking, Green 

Screen dan Animasi. 
Menurut Aris Hadi Sutopo, Proses Pembuatan Iklan 

Melalui beberapa tahapan: [7]. 

1. Mengenali khalayak sasaran 

Langkah pertama dalam mengembangkan atau 

merencanakan program pembuatan iklan adalah 

mengenali khalayak sasaran iklan di maksud, yaitu 

meneliti kelompok calon pembeli (produk yang di 

tawarkan) yang langsung akan dikenali iklan 

tersebut. Sejauh waktu dan dana memungkinkan, 

khalayak sasaran progam periklanan dimaksud 

merupakan pasar sasaran bagi pengusaha (barang 

atau jasa) yang bisa dikenali atau riset pasar dan 

studi pemilihan pasar. Banyak cara dapat dilakukan 

untuk melakukan penelitian dimaksud. Bisa 

menggunakan observasi tidak langsung, atau bisa 

juga menggunakan survey. Demikian pula alat pe-

nelitiannya bisa mengguankan wawancara atau 

angket tergantung berapa besar populasi atau sam-

pel yang menjadi sasaran iklan dimaksud. Dari 

hasil penelitian itu bisa diambil kesimpulan untuk 

menentukan teknik dan strategi pembuatan iklan-

nya, terutama dalam menetapkan tujuan iklannya. 

Data yang diperoleh dari penelitian itu bisa di-

jadikan dasar pertimbangan dalam menetapkan 

tujuan yang ingin dicapai oleh pemasangan (pem-

buatan) iklan itu[8]. 

2. Penetapan Tujuan Pemasangan Iklan 

Aspek terpenting dalam setiap upaya manajemen 

adalah mengembangkan tujuan yang berarti. Tanpa 

tujuan yang baik, sungguh sangat mustahil pe-

ngambilan keputusan bisa terarah dan terkendali.  

Tujuan dari penelitian ini untuk menarik konsumen 

sehingga banyak yang menginap di hotel mawar 

asri.  

3. Penyusunan Naskah Iklan 

Unsur sentral dalam rencana penyusunan program 

periklanan adalah naskah iklan, berupa pesan iklan 

yang diharapkan dapat dilihat atau ditonton kha-

layak sasaran (pada majalah, suratkabar, TV, dan 

internet) serta didengarnya (dari radio). Hal tersebut 

mencakup pesan untuk memperkenalkan keistime-

waan barang atau jasa yang dianggap penting bagi 

para calon pembeli dalam membuat keputusannya 

untuk mencoba dan membelinya guna dimiliki atau 

dipakainya. 

4. Penyusunan Anggaran Biaya 

Setelah menyusun tujuan pemasangan iklan dan 

naskah yang akan digunakannya, perusahaan harus 

menentukan banyaknya biaya yang akan dikeluar-

kan. Menentukan jumlah anggaran yang ideal sa-

ngatlah sulit, sebab tidak ada ukuran yang pasti 

dalam menentukan besarnya biaya bagi suatu iklan 

yang berhasil. 

5. Jadual Pemasangan Iklan 

Menyusun jadual pemasangan iklan memerlukan 

pula suatu pengertian tentang bagaimana pasar be-

reaksi. Kebanyakan perusahaan cenderung me-

ngikuti salah satu dari enam pendekatah berikut 

(Longman, 1971: 371-372). 

6. Memilih Media yang Tepat 

Iklan Hotel Mawar Asri Yogyakarta ini akan 

ditayangkan pada stasiun Jogja TV, pemilihan 

stasiun televisi ini berdasar dari diskusi antara 

pihak Hotel Mawar Asri Yogyakarta dan penulis. 

Jogja TV yang berlokasi di Jl. Wonosari Km. 9 

merupakan televisi lokal pertama yang berdiri di 

Yogyakarta.  

Jogja TV memiliki 18 jam siar yaitu pukul 06.00-

24.00 WIB. Dengan daya pancar 10 KW, coverage 

area Jogja TV meliputi Yogyakarta, Bantul, Sle-

man, Gunung Kidul dan Kulonprogo. Tidak hanya 

itu coverage area Jogja TV meliputi Surakarta, 

Boyolali, Sukoharjo, Wonogiri, Sragen, Klaten, 

Magelang, Purworejo, Kutoarjo, Banjarnegara, 

sebagian Kebumen, Wonosobo, Temanggung dan 

sekitarnya. 

 

 

 

 

 

 

 

 

Gambar 2. Alur Produksi iklan TV Hotel Mawar 

Asri 

 

Hasil dan Pembahasan 
Langkah dalam penerapan teknik motion tracking 

adalah:  

1. Pemberian effect Motion tracing kita import 

video yang akan diberi animasi tracking kita 

pilih pada tampilan menu tracker pilih Track 

Motion. 

 

Shooting Import 

Shooting Shooting 
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Gambar 3. Tampilan Tracking 

 

2. Pemilihan objek yang akan di tracing dengan 

memilih warna gelap didalam video setelah 

pemilihan selesai klik tombol play(analyze 

forward). 

 

 
 

Gambar 4. Tampilan analyze forward 

 

3. Setelah After Effect menganalisis frame demi 

frame video dan muncul box motion target. 

Setelah itu pilih Layer >New >Null Object 

 

 
 

Gambar 5. Tampilan null Objek 

 

4. Dalam menu tracker pilih edit target dan ada 

peringatan Motion Target pilih dalam layer 

Null 1 >OK.  

 

 
 

Gambar 6. Tampilan edit target 

 

5. Kemudian dalam menu Tracker klik Apply dan 

muncul peringatan Motion Tracker Apply 

Option, dalam pilihan Apply Dimensions pilih 

X and Y >OK 

6.  

 
 

Gambar 7. Tampilan apply Dimensions 

 

7. Setelah itu pilih, Layer >New >Text masukan 

text. Pada layer text menu parent tarik Layer 

text ke null 1. 

 

Rendering 

Rendering merupakan tahapan untuk mengeksport 

semua file video dan audio yang kita olah melalui 

Adobe Premiere  menjadi output video yang bisa 

dimainkan. Setelah semua tahapan selesai, mulailah 

tahapan untuk mengeksport file Premiere menjadi 

file video utuh. Langkah-langkahnya sebagi be-

rikut: 

Pilih menu File >Export >Media. 
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Gambar 8.  Mengeksport Media 

 

Muncul kotak dialog export media dan pengaturan 

video PAL DV Widescreen, untuk file output 

berbentuk AVI, disesuaikan dengan standart 

software. 

 

 
 

Gambar 9. Tampilan Export Setting 

 

Klik Queue lalu klik star rendering, tunggu sampai 

proses render selesai. 

 

 
 

Gambar 10. Tampilan Utama Iklan Hotel Mawar 

Asri Yogyakarta 

 

Kesimpulan dan Saran 

Berdasarkan hasil pembuatan iklan televisi pada 

Hotel Mawar Asri Yogyakarta, dapat ditarik 

beberapa kesimpulan yaitu : 

1. Pembuatan iklan televisi ini melewati tiga 

tahap, yaitu tahap pra produksi, tahap produksi, 

dan tahap pasca produksi. 

2. Iklan televisi hotel mawar Asri sudah dapat 

ditayangkan di stasiun televisi lokal RBTV. 

3. Iklan televisi untuk Hotel Mawar Asri 

menggunakan penggabungan Green screen, 

Motion Tracking dan Animasi. 

Saran dalam penelitian ini agar Hotel Mawar Asri 

Yogyakarta lebih dikenal masyarakat secara 

nasional sebaiknya ditayangkan di TV Nasional dan 

lebih luas apabila ingin dikenal secara global 

sebaiknya diposting di media social ataupun 

youtube. 
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